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Conventions
This help file uses the following conventions:
<>

Angle brackets that contain numbers separated by an ellipsis represent a range of values associated
with a bit or signal name—for example, DBIO<3..0>.

[]

Square brackets enclose optional items—for example, [response].

»

The » symbol leads you through nested menu items and dialog box options to a final action. The
sequence File»Page Setup»Options directs you to pull down the File menu, select the Page Setup
item, and select Options from the last dialog box.
This icon denotes a tip, which alerts you to advisory information.
This icon denotes a note, which alerts you to important information.

bold

Bold text denotes items that you must select or click on in the software, such as menu items and
dialog box options. Bold text also denotes parameter names, emphasis, or an introduction to a key
concept.

green

Underlined text in this color denotes a link to a help topic, help file, or Web address.

italic

Italic text denotes variables or cross references. This font also denotes text that is a placeholder for a
word or value that you must supply.

monospace Text in this font denotes text or characters that you should enter from the keyboard, sections of code,
programming examples, and syntax examples. This font is also used for the proper names of disk
drives, paths, directories, programs, subprograms, subroutines, device names, functions, operations,
variables, filenames, and extensions.
monospace Italic text in this font denotes text that is a placeholder for a word or value that you must supply.
italic

Key Terms
You may find the following definitions helpful as you use this document:
Digitizer
Downconverter
IF
Module
ni5660
PLL
RF
RF Vector Signal Analyzer

Digitizer A device that converts analog voltages into digital representations and stores the results in memory;
refers to the NI 5620 IF digitizer hardware module.

Downconverter A device that frequency-translates RF signals to center around a specified IF frequency—refers
to the NI 5600 3-slot RF downconverter hardware module.

IF

Refers to the signal passed from the NI 5600 RF downconverter module front panel OUTPUT connector
to the NI 5620 IF digitizer module front panel INPUT connector.

Module Refers to one of the hardware components of the RF Signal Analyzer: the NI 5620 IF digitizer or the
NI 5600 RF downconverter.

ni5660 Refers to the set of LabVIEW virtual instruments (VIs) included with the RF Vector Signal Analyzer
hardware. The ni5660 VIs operate both the NI 5620 IF digitizer module and the
NI 5600 RF downconverter module as a single instrument for data acquisition.

PLL

Phase-Locked Loop—an electronic circuit that controls an oscillator so that the circuit maintains a
constant phase angle relative to a reference signal.

RF

Radio Frequency—refers to the signal input to the INPUT connector on the NI 5600 RF downconverter
module front panel.

RF Vector Signal Analyzer Refers to the NI PXI-5660 RF Vector Signal Analyzer device consisting of the
NI 5620 IF digitizer module, the NI 5600 RF downconverter module, and software
included on the NI-RFSA CD. There is no single physical device labeled NI PXI5660 RF Vector Signal Analyzer.

ni5660 VI Fundamentals
This section provides an introduction to some basic concepts central to use of the
NI 5660 RF Vector Signal Analyzer and the ni5660 VIs.
ni5660 VI Programming Flow
Small Span Signals and Sample Rates
RF Attenuation and Signal Levels
Add-On Software for Measurement and Analysis
Programming Examples
Guidelines for Making Accurate Measurements
Refer to the Related Documentation section for more information about setup of
the RF Signal Analyzer hardware and software, and advanced use of the
ni5660 VIs.

Small Span Signals and Sample Rates

DDC Considerations
The IF digitizer module contains an onboard DDC chip that is enabled when
acquiring complex IQ data from signals less than 1.25 MHz in bandwidth. DDC
span settings must be considered when acquiring signals using the DDC.

DDC Span Settings
The DDC hardware has eight discrete bandwidth settings. The DDC hardware
bandwidth setting is automatically calculated based on the value of the
bandwidth input parameter of the ni5660 Configure for IQ VI or the span input
parameter of the ni5660 Configure for Spectrum VI. Each DDC bandwidth
setting is associated with decimation and sample rates according to the following
formula:

You must always specify a ni5660 Configure for IQ VI bandwidth parameter
wider than the bandwidth of your incoming modulated wave to avoid data loss.
Tip DDC bandwidth settings have a large effect on application speed because they determine the amount
of IQ data acquired and processed. If you modify your test setup to use a VI bandwidth parameter
narrow enough for the DDC hardware to use a smaller bandwidth setting, your application realizes a
significant increase in speed.

The following table relates DDC span settings to decimation and sample rates:
Associated
DDC Hardware
Resulting
Decimation
Bandwidth Setting
Sample Rate
Rate
1.25 MHz

32

2 MS/s

800 kHz

64

1 MS/s

400 kHz

128

500 kS/s

200 kHz

256

250 kS/s

100 kHz

512

125 kS/s

50 kHz

1024

62,500 S/s

25 kHz

2048

31,250 S/s

12.5 kHz

4096

15,625 S/s

Bandwidth Coercion
If the bandwidth parameter specified in the ni5660 Configure for IQ VI or the
ni5660 Configure for Spectrum VI does not match an available DDC bandwidth
setting, the DDC bandwidth setting is coerced to the next graduation above the
value specified in the bandwidth parameter. For example, a bandwidth input
value of 801 kHz sets the DDC bandwidth to 1.25 MHz.
If the DDC bandwidth setting is coerced, the raw IQ data is acquired using a
DDC bandwidth setting wider than the bandwidth parameter specified in the
ni5660 Configure for IQ VI or the ni5660 Configure for Spectrum VI.
To find the sample rate of the IQ data returned from the DDC, use the reciprocal
of the dt value output by the ni5660 Read IQ VI or the ni5660 Fetch IQ VI. You
can also use the MT Get Attributes VI to query the value of the receiver»IQ
sample rate attribute.
Note For more information on using the MT Get Attributes VI, refer to the Modulation VIs Online Help,
accessible at Start»Programs»National Instruments»Modulation»LabVIEW Support, or run the VI
and press <Ctrl-H>.

RF Attenuation and Signal Levels
This section describes how attenuation is handled by the ni5660 VIs. The user
modifies attenuation through the reference level and attenuation parameters of
the ni5660 Configure for Spectrum VI and the ni5660 Configure for IQ VI.
The auto attenuation option automatically selects an attenuation setting based
on the user-specified reference level. Refer to the ni5660 Configure for
Spectrum VI and the ni5660 Configure for IQ VI for details.

The Hardware
The RF downconverter module has five programmable attenuators: three RF
attenuators at the beginning of its signal chain and two IF attenuators near the
end of the signal chain. They are set up in the following sequence:
Attenuator Sequence
Attenuator

Asserted Value

RF Attenuator 1 20 dB
RF Attenuator 2 20 dB
RF Attenuator 3 10 dB
IF Attenuator 1 20 dB
IF Attenuator 2 10 dB

Attenuators are either set/asserted or not set/asserted. This allows a dynamic
range of RF attenuation from 0–50 dB and a dynamic range of IF attenuation
from 0–30 dB. Overall attenuation within the signal chain is the sum of all the
attenuators set, for a range of 0–80 dB.

Reference Level and Mixer Level
Understanding the parts played by the reference level and the mixer level is key
to setting the individual attenuators. NI–RFSA sets the RF attenuators first.
Let D be the difference between the reference level and the mixer level, such that
D = referenceLevel - mixerLevel
This formula correlates directly with the range of possible RF attenuator settings.
Recall that the RF attenuators have a range of 0 - 50 dB. The coercions described
in the previous section ensure that
mixerLevel < referenceLevel
and that
referenceLevel - mixerLevel ≤ 50 dBm.
D is then directly proportional to the total RF attenuation, a value between 0-50
dB.
The attenuators are set as follows (refer to the Attenuator Sequence table above):
RF Attenuator Settings
D Attenuators
0

None are set

10 RF Attenuator 3
20 RF Attenuator 1
30 RF Attenuators 1 and 3
40 RF Attenuators 1 and 2
50 RF Attenuators 1, 2, and 3

Add-On Software for Measurement and Analysis
The ni5660 VIs perform data acquisition using the RF Signal Analyzer. NI
provides add-on software toolkits, such as the Spectral Measurements Toolkit
(included) and the Modulation Toolkit, which extend the capability of the RF
Signal Analyzer to include frequency- and modulation-domain measurements
and analysis of analog- and digitally-modulated IF signals.
Note To enable proper operation of the RF Signal Analyzer, you must install the Spectral Measurements
Toolkit CD after installing the NI-RFSA CD.

Spectral Measurements Toolkit
Use the Spectral Measurements Toolkit (SMT) VIs and functions for frequencydomain analysis, measurement, and display of data acquired using the RF Vector
Signal Analyzer. The SMT can perform several operations, including the
following:
Zoom FFT processing and spectrum averaging
Spectral measurements such as band power, adjacent channel power, and
peak frequency and magnitude Spectrogram display and analysis
RF Vector Signal Analyzer hardware configuration for frequency-domain
measurements
Refer to the Spectral Measurements Toolkit documentation, accessible from
Start»Programs»National Instruments»Spectral Measurements, for
complete information about SMT VIs and functions.

Modulation Toolkit
The Modulation Toolkit integrates with SMT and NI-RFSA for
modulation/demodulation measurements and analysis. The Modulation Toolkit
VIs and functions generate and analyze analog and digital modulated IF signals
in FSK, MSK, PSK, QAM, AM, FM, and PM formats. The Modulation Toolkit
is capable of measuring several aspects of signals generated by a unit under test,
including the following:
Modulation quality and modulation index
Signal impairments, bit error rate, and phase noise
Carrier frequency drift and complementary cumulative distribution
functions (CCDF) values
Refer to the Modulation Toolkit documentation, accessible from
Start»Programs»National Instruments»Modulation, for complete
information about Modulation Toolkit VIs and functions.

Programming Examples
NI-RFSA includes several examples for LabVIEW. These examples are intended
to serve as interactive tools, programming models, and building blocks in your
own applications.
With LabVIEW running, select Help»Find Examples to launch the LabVIEW
Example Finder. The Example Finder offers two ways to access all installed
LabVIEW example VIs and their descriptions:
Click the Browse tab to locate NI-RFSA examples by task at Hardware
Input and Output»Modular Instruments»NI-RFSA or by directory
structure at instr»ni5660.
Click the Search tab to search all installed examples by keyword. Enter
the keyword power, for instance, to locate an example that demonstrates
making power in band measurements using the RF Signal Analyzer.
All installed NI-RFSA files are located in the <LabVIEW
home>\examples\instr\ni5660 folder.

Spectral Measurements Toolkit Examples for the RF Signal
Analyzer
The Spectral Measurements Toolkit includes LabVIEW examples for the RF
Signal Analyzer. You can access the Spectral Measurements Toolkit examples at
Start»Programs»National Instruments»Spectral Measurements.
Note Refer to the Spectral Measurements Toolkit documentation, accessible at
Start»Programs»National Instruments»Spectral Measurements, for more information about the
Spectral Measurements Toolkit software and examples.

Examples Available Online
Examples for the RF Signal Analyzer are also available online at
ni.com/examples. Available examples demonstrate integration of the RF Signal
Analyzer with the RF Signal Generator and NI toolkit software, including the
Modulation Toolkit. Refer to the NI Developer Zone on the Web for more
information.
Refer to the Programming the NI 5660 in LabWindows/CVI section in the
NI 5660 Getting Started Guide for more information on the software
subcomponents that install with the ni5660 VIs. The NI 5660 Getting Started
Guide is accessible at Start»Programs»National Instruments»NIRFSA»Documentation.

Guidelines for Making Accurate Measurements
This section provides guidelines for making accurate measurements with the RF
Signal Analyzer hardware and software. Click one of the following
measurements for more information:
General Amplitude/Spectrum
Harmonic Distortion
Two-Tone Third-Order Intermodulation Distortion
1 dB Gain Compression
Noise Figure

General Amplitude/Spectrum Measurement
Amplitude dynamic range is the difference between the maximum input level of
a device and its minimum detectable signal level.
Dynamic range estimates the ability of the RF Signal Analyzer to distinguish and
measure the amplitude difference of two signals. The RF Signal Analyzer can
make signal measurements over a frequency range from 9 kHz to 2.7 GHz, and
over an amplitude dynamic range of greater than 100 dB.
Signals of large amplitude can saturate the system and cause spurious effects.
These "spurs" may be large enough to be mistaken for real signals. Avoid this
effect by properly adjusting the amplitude of the incoming signal. Achieving
proper signal levels may involve attenuating the signal before it gets to the first
mixer, either by programming the internal attenuators or by using external
attenuation.
The RF Signal Analyzer must be properly configured before making a
measurement. A small signal can be buried in noise if the resolution bandwidth
setting is too large. To measure a small signal, make sure that the input
attenuators are switched off and lower the resolution bandwidth setting to reduce
the noise content.
For signals below the noise floor of the RF Signal Analyzer, use an external lownoise amplifier (LNA) in front of the RF Signal Analyzer to raise the signal
level. If the update speed is not fast enough to resolve a signal due to the
processing demands imposed by a narrow resolution bandwidth, an LNA helps
provided it does not significantly affect system linearity. For example, with a
signal level of 100 dBm, set the resolution bandwidth to 1 kHz or less.

Harmonic Distortion Measurement
Harmonic distortion is a measure of the amount of power contained in the
harmonics of a fundamental signal. Harmonic distortion is inherent to devices
and systems that possess nonlinear characteristicsthe more nonlinear the device,
the greater its harmonic distortion.
Harmonic distortion can be expressed as a power ratio or as a percentage ratio.
Use the following formula to express it as a power ratio:
where PHD is the power of the harmonic distortion in dBc, Pfund is the
fundamental signal power in dB or dBm, and Pharm is the power of the harmonic
of interest in dB or dBm.
Convert the powers to voltages to express harmonic distortion as a percentage
ratio:
In some applications, the harmonic distortion is measured as a total percentage
harmonic distortion (THD). This measurement involves the power summation of
all the harmonics in the spectrum band, defined in the following equation:
A typical setup to perform a harmonic distortion measurement is shown in the
figure below. A lowpass or bandpass filter passes the fundamental signal while
suppressing its harmonics. This setup injects a very clean sinusoidal signal into
the unit under test (UUT). Any harmonic content at the UUT output is assumed
to be generated by the UUT instead of the source.
Typical Harmonic Distortion Measurement Setup

Understanding the RF Signal Analyzer Harmonic Distortion
Limits
As with all analyzers, there are residual distortions inherent in the RF Signal
Analyzer. It is important that these distortions do not corrupt your measurement.
The level of internal distortion is a function of the linearity of the system, which
is primarily determined at the input mixer. Increasing input power at the mixer
increases distortion, so if the input signal is too high, the internally generated
harmonics overwhelm the harmonics of the original signal.
The specifications for the second- and third-order harmonic intercept points
provide sufficient information about the linearity of the system. For example, to
measure a second-order harmonic at –70 dBc, the fundamental power at the
mixer input has to satisfy the following condition:
where IIP2 is the second-order intercept point.
If the input signal power is greater than this value, the signal must be attenuated
before the first mixer. There is an upper limit on the amount of attenuation you
can switch in because the noise floor rises by the same amount as the
attenuation. To lower the noise level decrease the resolution bandwidth, but keep
in mind that there is also a practical lower limit on the resolution bandwidth.
Decreasing the resolution bandwidth increases measurement time.
The harmonic distortion dynamic range (HDDR) indicates the minimum
distortion the RF Signal Analyzer can measure, which is about 96 dBc/Hz for the
RF Signal Analyzer.

Choosing an Optimal Setting for the RF Signal Analyzer
Because the level of harmonic distortion is often unknown, the optimal
attenuation level can be difficult to determine. Complete the following steps to
find the proper attenuation setting for the RF Signal Analyzer:
1. Set the attenuation so that the input power at the mixer is about 30 dBm.
When using the RF Signal Analyzer Demo Panel,
mixer level = reference level – attenuation.
2. Tune to the harmonic frequency of interest and then decrease the
resolution bandwidth until the harmonic spur appears.
3. Increase the attenuation level. If the harmonic spur decreases, attenuate
more.
4. Repeat step 3 until the harmonic level does not decrease any further.
Attenuation does not lower the harmonics of the original signal; it only
lowers the internally generated ones.
5. Decrease the resolution bandwidth to lower the noise floor.
This setting is the optimal attenuation setting.

Two-Tone Third-Order Intermodulation Distortion
Measurement
Two-tone third-order intermodulation distortion (IMD3) is the measure of the
third-order distortion products produced by a nonlinear device when two tones
closely spaced in frequency are fed into its input. This distortion product is
usually so close to the carrier that it is almost impossible to filter out and can
cause interference in multichannel communications equipment.
If F1 and F2 are the frequencies of the two tones, then the third-order distortion
products occur on both sides of these tones at 2F2 – F1 and 2F1 – F2. Assuming
that the power levels of the two tones are equal, IMD3 is the difference between
the power of the fundamental signals and the third-order products, as defined in
the following equation:
where o refers to the output of the UUT, Po3 is the power level of one of the
output third-order products, and Po is the power level of one of the fundamental
tones.
The math becomes more involved if the powers of the two tones are different.
Once the IMD3 is measured, calculate the UUT output third-order intercept point
(OIP3) using the following equation:
The input third-order intercept point (IIP3) is defined as:
where G is the gain of the device. The IIP3 number quantifies the third-order
linearity of a device. Use the IIP3 specification of the RF Signal Analyzer as a
guide to optimize its settings when measuring the IMD3 of an external device.
The two tones injected into the UUT must be free from any third-order products.
These two tones are combined, or summed, at or before the UUT input. If they
are not well isolated, they intermodulate with each other and cause distortion. A
signal combiner with good input-to-input isolation is recommended to minimize
distortion of the input tones.

Measurement Setup
A typical IMD3 measurement setup is shown in the figure below. Lowpass filters
are employed at the source outputs to suppress harmonics.
Typical IMD3 Measurement Setup

Understanding Two-Tone Third-Order Intermodulation
Distortion Limits of the RF Signal Analyzer
The RF Signal Analyzer generates its own distortion spurs, which are capable of
swamping the Po3 of the UUT and giving rise to an erroneous measurement. Too
much power at the signal input of the RF Signal Analyzer may drive the system
into a nonlinear region of operation and produce very large distortion products.
Choosing an appropriate attenuation setting for the RF Signal Analyzer
minimizes its IMD3 contribution to the measurement. The IMD3 improves by
2 dB for every 1 dB of input power decrement.
To measure the IMD3 of a UUT, input power to the RF Signal Analyzer mixer
must satisfy the following condition:
where IIP3rfsa is the input third-order intercept point of the RF Signal Analyzer
(about 10 dBm). For example, to accurately measure an IMD3 of 80 dBc the
input power to the mixer must be less than 31.5 dBm.
If the powers of two-tone signals are larger than this optimal level, they must be
attenuated, either with the attenuators internal to the RF Signal Analyzer or with
external attenuators. However, as attenuation raises the noise floor of the RF
Signal Analyzer, there is a limit to how much attenuation can be used before
noise overwhelms the distortion spurs. Its spurious-free dynamic range (SFDR)
specification indicates the largest IMD3 value the RF Signal Analyzer can
accurately measure, assuming 0 dB attenuation and input signals whose powers
satisfy the above equation.

Choosing an Optimal Setting for the RF Signal Analyzer
Complete the following steps to set optimal attenuation levels for an IMD3
measurement when the level of the third-order distortion spur (Po3) is unknown:
1. Set the attenuation so that the input power at the mixer is about 30 dBm.
When using the RF Signal Analyzer Demo Panel,
mixer level = reference level – attenuation.
2. Tune to the third-order distortion product frequency of interest, either
2F2 – F1 or 2F1 – F2. Then decrease the resolution bandwidth until a
distortion spur appears.
3. Increase the attenuation level.
4. If the harmonic spur decreases, repeat step 3.
5. Repeat step 4 until the harmonic level does not decrease any further.
Attenuation does not lower the distortion products of the signal; it only
lowers the distortion products generated internally to the RF Signal
Analyzer. Decrease the resolution bandwidth to lower the noise floor.
This setting is the optimal attenuation setting.

Noise Figure Measurement
All devices have inherent noise. When noise is quantified, it is usually referred
to the device input. In other words, all noise power a UUT inherits is assumed to
come from its input. The noise figure of a UUT is the ratio in dB of its noise
power to the noise power that a matched resistive load would deliver at room
temperature. If you terminate a UUT input with a matched resistive load
(typically 50 Ω) and measure the noise power density at its output (No), the noise
figure (NF) is given by the following equation:

where G is the power gain of the UUT, k ≈ 1.38 ×10-23 is Boltzmanns constant,
and T0 ≈ 290° K is the room temperature.
If you use the RF Signal Analyzer to measure the output noise of a UUT, the
result of the measurement contains not only UUT noise but also noise intrinsic to
the RF Signal Analyzer. If the UUT gain (G) is known, compute the noise figure
of the UUT with the following equation:

where Nrfsa is the noise measured by the RF Signal Analyzer when its input is
terminated with a matched resistive load and Nm is the measured noise with
UUT attached. Both Nrfsa and Nm are given in Watts; G is a linear power gain.

Measurement Setup
A typical noise figure measurement setup is shown in the figure below:

Typical Noise Figure Measurement Setup

Measuring Noise Figure with the RF Signal Analyzer
To measure the noise figure, perform the following steps:
1. Turn on the RF Signal Analyzer and let it warm up for 20 minutes.
2. Turn on the UUT if it is active.
3. Set the RF Signal Analyzer to the frequency of interest, and decrease the
resolution bandwidth to about 1 kHz.
4. Terminate the RF Signal Analyzer input with a broadband resistive load.
5. Obtain an average reading of the noise level. Make sure to take enough
readings to obtain a good average.
6. Convert a reading taken in dBm to watts and normalize it to 1 Hz by
dividing by the resolution bandwidth. This value is the noise floor of the
RF Signal Analyzer at that frequency, which is Nrfsa in this document.
7. Remove the load termination from the RF Signal Analyzer input.
8. Attach the output of the UUT to the RF Signal Analyzer input.
9. Input a known small signal into the UUT input. This signal level should
be less then 10 dB below the 1 dB compression point of the UUT.
10. Measure the output signal level on the RF Signal Analyzer to determine
the gain (G) of the UUT.
11. Remove the signal source and terminate the UUT input with a broadband
resistive load.
12. Make another averaged reading of the noise with the UUT attached by
repeating steps 5 and 6. This average is the noise value for the UUT and
the RF Signal Analyzer (Nm).
13. Substitute your values into the equation:

as follows to determine the UUT noise figure:
The value from step 6 is Nrfsa
The value from step 10 is G
The value from step 12 is Nm

ni5660 VI Programming Reference
This section provides reference and programming information regarding the
ni5660 VIs and installed examples.
Refer to the Fundamentals section for an introduction to basic concepts of the
ni5660 VIs. For in-depth information on programming, refer to the ni5660
LabVIEW VI Reference for more information about using specific LabVIEW
VIs. Refer to the Related Documentation section for more information about
advanced use of the ni5660 VIs, and setup of the RF Signal Analyzer hardware
and software.

ni5660 LabVIEW VI Reference Help
Use the ni5660 VIs on the ni5660 palette to build the
block diagram.
Click the icons for VI descriptions.

ni5660 Close
This VI performs the following actions:
Aborts any signal acquisition in progress.
Terminates the instrument I/O session.
Destroys the instrument driver session and any attributes.
Call this VI to end every session with the ni5660 VIs.

receiver info in is the instrument handle that you obtain from the ni5660 Initialize VI. The handle
identifies a particular RF Signal Analyzer session.
error in accepts error information wired from previously called VIs.
The pop-up option Explain Error (or Explain Warning) gives more information about the error
displayed.

status boolean is either TRUE (X) for an error, or FALSE
(checkmark) for no error or a warning. The pop-up option
Explain Error (or Explain Warning) gives more information
about the error displayed.
code input identifies the error or warning. The pop-up option
Explain Error (or Explain Warning) gives more information
about the error displayed.
source string describes the origin of the error or warning. The
pop-up option Explain Error (or Explain Warning) gives more
information about the error displayed.
error out passes error or warning information out of a VI to be used by other VIs. The pop-up option
Explain Error (or Explain Warning) gives more information about the error displayed.

status is TRUE (X) if an error occurred, or FALSE (checkmark)
for no error or a warning. The pop-up option Explain Error (or
Explain Warning) gives more information about the error
displayed.
code identifies the error or warning. The pop-up option Explain
Error (or Explain Warning) gives more information about the
error displayed.
source describes the origin of the error or warning. The pop-up
option Explain Error (or Explain Warning) gives more
information about the error displayed.

ni5660 Configure for IQ
This VI configures the RF Signal Analyzer hardware to acquire a time-domain
signal with IQ settings you specify. Carrier frequency, bandwidth, and
acquisition time settings define the IQ data. You can configure the acquisition
to be finite or continuous.
This VI configures the reference level and attenuation settings used by the RF
downconverter module, and the horizontal settings and acquisition type used
by the IF digitizer module.

acquisition type specifies whether the acquisition is finite or continuous.
Default Value: FINITE
receiver info in is the instrument handle that you obtain from the ni5660 Initialize VI. The handle
identifies a particular RF Signal Analyzer session.
carrier frequency (Hz) specifies the expected carrier frequency of the incoming signal for
demodulation. The RF Signal Analyzer tunes to this frequency. This value may be coerced based on
hardware settings and downconversion specifications.
Default Value: 100 MHz
bandwidth (Hz) specifies the 0.01 dB down filter bandwidth of the software filter that is used in the
downconversion process. Set this value equal to the bandwidth in Hz of the modulated wave. This
value may be coerced based on hardware settings and downconversion specifications.
Default Value: 1 MHz
time duration (sec) specifies the time duration/interval in seconds over which to acquire IQ data. This
control is ignored if acquisition type is set to CONTINUOUS.
Default Value: 10 µseconds
error in accepts error information wired from previously called VIs.
The pop-up option Explain Error (or Explain Warning) gives more information about the error
displayed.

status boolean is either TRUE (X) for an error, or FALSE
(checkmark) for no error or a warning. The pop-up option
Explain Error (or Explain Warning) gives more information
about the error displayed.
code input identifies the error or warning. The pop-up option
Explain Error (or Explain Warning) gives more information
about the error displayed.
source string describes the origin of the error or warning. The
pop-up option Explain Error (or Explain Warning) gives more

ni5660 Configure for Spectrum
This VI configures the RF Signal Analyzer hardware to acquire a frequencydomain spectrum with spectral settings you specify. Center frequency, span,
and resolution bandwidth parameter settings define the spectrum. You can
also specify window type, number of spectral lines, and resolution
bandwidth (RBW) definition.
This VI configures the reference level and attenuation settings used by the RF
downconverter module, and the horizontal settings and acquisition type used
by the IF digitizer module. It returns a correction factor array. Wire this output
to the correction factor input parameter of the ni5660 Read Averaged Power
Spectrum VI or ni5660 Read FFT Spectrum VI.

receiver info in is the instrument handle that you obtain from the ni5660 Initialize VI. The handle
identifies a particular RF Signal Analyzer session.
advanced settings parameters specify additional spectrum characteristics. These optional inputs are
necessary only if you want to use a specific window, define the exact number of spectral lines, or
change the RBW definition.

window specifies the time-domain window the VI uses. The VI
handles the scaling effects of the window. You can select one of
the following values for window:
0:
1:
2:
3:
4:
5:
6:
7:
8:
9:

Uniform (no window)
Hanning
Hamming
Blackman-Harris
Exact Blackman
Blackman
Flat Top
4-term Blackman-Harris
7-term Blackman-Harris
Low side lobe

Default Value: 7-term Blackman-Harris

ni5660 Configure Reference Clock
Use this function to configure the reference clock source for the RF Signal
Analyzer. Reference clock source options include the high-stability ovencontrolled crystal oscillator (OCXO) onboard the RF downconverter module
(On Board Clock), a 10 MHz reference clock from an external source (Ref
In), or the PXI backplane (PXI Clock 10). You can optionally use this VI to
drive the PXI backplane using the specified reference clock source.

receiver info in is the instrument handle that you obtain from the ni5660 Initialize VI. The handle
identifies a particular RF Signal Analyzer session.
clock source specifies the RF Signal Analyzer reference clock source. Select one of the following
options:

Ref In

Locks the RF downconverter module reference
to an external reference signal connected to the
FREQ REF IN connector on the RF
downconverter module front panel.

On Board
Clock

Sets the RF downconverter module internal
reference clock as the RF downconverter
module timebase.

PXI Clock 10 Locks the RF downconverter module internal
reference to the PXI backplane. This option is
useful only when the onboard PXI clock is
locked to a more accurate reference (such as a
PXI-6608 or another RF downconverter module)
installed in PXI Slot 2. To use this option,
connect the PXI 10 MHz I/O connector to the
FREQ REF IN connector on the RF
downconverter module front panel.
Default Value: On Board Clock
drive backplane clock specifies whether the reference clock specified in the clock source parameter is
propagated to the PXI backplane. When drive backplane clock is FALSE (default), the PXI backplane
is independent of the RF Signal Analyzer timebase. When drive backplane clock is TRUE, the PXI
backplane is driven by the specified RF Signal Analyzer clock source.
Default Value: FALSE
Note This option is only available when the RF downconverter module is installed in PXI Slot 2, and
the PXI 10 MHz I/O connector is wired to the 10 MHz OUT connector on the NI 5600
RF downconverter module front panel as shown in Overview.
digitizer PLL lock time (sec) specifies time in seconds for which the digitizer module reference clock
must be phase-locked to the 10 MHz reference of the downconverter module before execution. For
most measurements, the PLL may be considered stable after 1 second, but NI recommends a digitizer

ni5660 Initialize
Purpose
This VI performs the following initialization actions:
Creates a new instrument driver session to the RF signal analyzer, using
the downconverter device number and the digitizer resource name
you specify
Sends initialization commands to reset both hardware modules to a
known state necessary for NI-RFSA operation
Sets the RF downconverter module onboard clock as the RF Signal
Analyzer reference clock source. When all the PLLs lock correctly, the
STATUS light on the RF downconverter module is activated.

downconverter device number specifies the number of the RF downconverter module to initialize.
This number is obtained from Measurement & Automation Explorer (MAX). Specify the
downconverter device number without modifiers.
Default Value: 1
digitizer resource name specifies specifies the resource name of the IF digitizer module to initialize.
This number is obtained from Measurement & Automation Explorer (MAX). Specify the digitizer
resource name using the following syntax:
DAQ::DeviceNumber.
Default Value: DAQ::2
digitizer PLL lock time (sec) specifies time in seconds for which the digitizer module reference clock
must be phase-locked to the 10 MHz reference of the downconverter module before execution. For
most measurements, the PLL may be considered stable after 1 second, but NI recommends a digitizer
PLL lock time of 4 seconds to ensure complete settling and utmost accuracy for phase measurements.
Default Value: 1 second

Tip Setting PLL lock time to 0 means that the VI does not wait
for the PLL to settle before returning. Use this option when it is
acceptable for your program to continue executing while the
digitizer module PLL settles in the background, or when you
intend to change the reference clock configuration using the
ni5660 Configure Reference Clock VI.
reset device specifies whether the RF Signal Analyzer is reset at each call to this VI. When reset
device is TRUE, the digitizer module is reconfigured with each call to this VI. When reset device is
FALSE, this VI employs internal state caching that resets the digitizer module only on the initial call,
even if this VI is called repetitively in your program.
Default Value: TRUE
error in accepts error information wired from previously called VIs.
The pop-up option Explain Error (or Explain Warning) gives more information about the error
displayed.

ni5660 Acquire IQ Palette
Use the VIs on the ni5660»Acquire IQ subpalette to
acquire continuous and finite IQ data.
Click the icons for VI descriptions.

ni5660 Fetch IQ
This VI returns the IQ waveform acquired by the RF Signal Analyzer during a
previously initiated acquisition. This VI returns IQ data computed through a
process of filtering, decimation, and downconversion. Use this VI with the
ni5660 Initiate VI when continuously acquiring data.
Note Continous IQ acquisition is only possible for bandwidths smaller than 1.25 MHz. Refer to Small
Span Signals and Sample Rates for more information.

receiver info in is the instrument handle that you obtain from the ni5660 Initialize VI. The handle
identifies a particular RF Signal Analyzer session.
samples to read specifies the number of samples to fetch. A value of –1 fetches the actual record
length.
Default Value: –1
timeout (sec) specifies the maximum amount of time in seconds to wait for the acquisition to finish.
After this amount of time, the VI returns an error if the acquisition is not complete. If this parameter is
set to 0, it returns immediately without checking the acquisition status. If this parameter is set to –1, the
function waits forever.
Default Value: 5 seconds
error in accepts error information wired from previously called VIs.
The pop-up option Explain Error (or Explain Warning) gives more information about the error
displayed.

status boolean is either TRUE (X) for an error, or FALSE
(checkmark) for no error or a warning. The pop-up option
Explain Error (or Explain Warning) gives more information
about the error displayed.
code input identifies the error or warning. The pop-up option
Explain Error (or Explain Warning) gives more information
about the error displayed.
source string describes the origin of the error or warning. The
pop-up option Explain Error (or Explain Warning) gives more
information about the error displayed.
receiver info out passes a reference to your instrument session to the next VI. receiver info was
obtained from the ni5660 Initialize VI.

Note Do not modify the contents of this wire manually.
IQ waveform contains the baseband (downconverted) time-domain waveform for demodulation. This
cluster contains the following elements:

t0 returns the trigger (start) time of the acquired signal.
dt returns the time interval between data points in the acquired

ni5660 Initiate IQ
This VI initiates an IQ waveform acquisition. Use this VI with ni5660 Fetch IQ
VI when performing finite or continuous acquisition.
Note Continous IQ acquisition is only possible for bandwidths smaller than 1.25 MHz. Refer to Small
Span Signals and Sample Rates for more information.

receiver info in is the instrument handle that you obtain from the ni5660 Initialize VI. The handle
identifies a particular RF Signal Analyzer session.
error in accepts error information wired from previously called VIs.
The pop-up option Explain Error (or Explain Warning) gives more information about the error
displayed.

status boolean is either TRUE (X) for an error, or FALSE
(checkmark) for no error or a warning. The pop-up option
Explain Error (or Explain Warning) gives more information
about the error displayed.
code input identifies the error or warning. The pop-up option
Explain Error (or Explain Warning) gives more information
about the error displayed.
source string describes the origin of the error or warning. The
pop-up option Explain Error (or Explain Warning) gives more
information about the error displayed.
receiver info out passes a reference to your instrument session to the next VI. receiver info was
obtained from the ni5660 Initialize VI.

Note Do not modify the contents of this wire manually.
error out passes error or warning information out of a VI to be used by other VIs. The pop-up option
Explain Error (or Explain Warning) gives more information about the error displayed.

status is TRUE (X) if an error occurred, or FALSE (checkmark)
for no error or a warning. The pop-up option Explain Error (or
Explain Warning) gives more information about the error
displayed.
code identifies the error or warning. The pop-up option Explain
Error (or Explain Warning) gives more information about the
error displayed.
source describes the origin of the error or warning. The pop-up
option Explain Error (or Explain Warning) gives more
information about the error displayed.

ni5660 Read IQ
This VI returns the waveform acquired by the RF Signal Analyzer. This VI
initiates an acquisition and returns both a scaled voltage waveform with timing
information, and IQ data computed through a process of filtering, decimation,
and downconversion.

receiver info in is the instrument handle that you obtain from the ni5660 Initialize VI. The handle
identifies a particular RF Signal Analyzer session.
timeout (sec) specifies the maximum amount of time in seconds to wait for the acquisition to finish.
After this amount of time, the VI returns an error if the acquisition is not complete. If this parameter is
set to 0, it returns immediately without checking the acquisition status. If this parameter is set to –1, the
VI waits forever.
Default Value: 5 seconds
error in accepts error information wired from previously called VIs.
The pop-up option Explain Error (or Explain Warning) gives more information about the error
displayed.

status boolean is either TRUE (X) for an error, or FALSE
(checkmark) for no error or a warning. The pop-up option
Explain Error (or Explain Warning) gives more information
about the error displayed.
code input identifies the error or warning. The pop-up option
Explain Error (or Explain Warning) gives more information
about the error displayed.
source string describes the origin of the error or warning. The
pop-up option Explain Error (or Explain Warning) gives more
information about the error displayed.
receiver info out passes a reference to your instrument session to the next VI. receiver info was
obtained from the ni5660 Initialize VI.

Note Do not modify the contents of this wire manually.
IQ waveform returns the baseband (downconverted) time-domain data for demodulation. This cluster
contains the following elements:

t0 returns the trigger (start) time of the acquired signal.
dt returns the time interval between data points in the acquired
signal. The IQ data sampling rate is the reciprocal of this value.
Y returns the complex-valued time domain data array. The real
and imaginary parts of this complex data array correspond to the
in-phase (I) and quadrature-phase (Q) data, respectively.
Note To calculate the instantaneous power of a sampled

ni5660 Acquire Spectrum Palette
Use the VIs on the ni5660»Acquire Spectrum subpalette
to acquire averaged power and FFT spectrum data.
Click the icons for VI descriptions.

ni5660 Read Averaged Power Spectrum
This VI computes the averaged power spectrum that corresponds to the spectral
settings specified in the ni5660 Configure for Spectrum VI. The VI returns a
cluster that contains the averaged power spectrum in V2rms, starting at
frequency f0 and frequency interval df. You can perform RMS averaging with
linear, exponential, or peak-hold weighting.

receiver info in is the instrument handle that you obtain from the ni5660 Initialize VI. The handle
identifies a particular RF Signal Analyzer session.
number of averages specifies either the number of averages to complete for linear weighting, or the
time constant for exponential weighting. The VI stops the averaging process and returns the final result
after number of averages is complete.
Default Value: 10 averages
averaging weighting type specifies the type of weighting used by the VI:
Linear weighting specifies that each measurement has equal weighting during the averaging
process.
Exponential weighting specifies that each new measurement has less weighting than old
measurements and that the averaging is continuous. The averaging process computes the
exponentially weighted average for measurement i as
Avg [i] = 1/N * X + (N - 1)/N * Avg[i - 1]
where X is the new measurement, Avg[i - 1] is the previous average and N is the number of
averages.
Peak hold weighting specifies that the VI calculates and retains the maximum rms levels for
each frequency bin across FFT records. The peak rms value for each bin is returned.
Default Value: linear
correction factor specifies the array of correction factors previously computed by the ni5660
Configure for Spectrum VI. Wire the correction factor output of the ni5660 Configure for Spectrum
VI directly to this input. Do not modify the values.
error in accepts error information wired from previously called VIs.
The pop-up option Explain Error (or Explain Warning) gives more information about the error
displayed.

status boolean is either TRUE (X) for an error, or FALSE
(checkmark) for no error or a warning. The pop-up option
Explain Error (or Explain Warning) gives more information
about the error displayed.
code input identifies the error or warning. The pop-up option
Explain Error (or Explain Warning) gives more information
about the error displayed.
source string describes the origin of the error or warning. The
pop-up option Explain Error (or Explain Warning) gives more

ni5660 Read FFT Spectrum
This VI computes the FFT spectrum that corresponds to the spectral settings
specified in the ni5660 Configure for Spectrum VI. The VI returns a cluster that
contains the FFT spectrum in Vrms, starting at frequency f0 and frequency
interval df. Wire the FFT spectrum output to averaging and/or measurement
VIs in the Spectral Measurements Toolkit.

receiver info in is the instrument handle that you obtain from the ni5660 Initialize VI. The handle
identifies a particular RF Signal Analyzer session.
correction factor specifies the correction factor previously computed by the ni5660 Configure for
Spectrum VI. Wire the correction factor output of the ni5660 Configure for Spectrum VI directly to
this input. Do not modify the values.
error in accepts error information wired from previously called VIs.
The pop-up option Explain Error (or Explain Warning) gives more information about the error
displayed.

status boolean is either TRUE (X) for an error, or FALSE
(checkmark) for no error or a warning. The pop-up option
Explain Error (or Explain Warning) gives more information
about the error displayed.
code input identifies the error or warning. The pop-up option
Explain Error (or Explain Warning) gives more information
about the error displayed.
source string describes the origin of the error or warning. The
pop-up option Explain Error (or Explain Warning) gives more
information about the error displayed.
receiver info out passes a reference to your instrument session to the next VI. receiver info was
obtained from the ni5660 Initialize VI.

Note Do not modify the contents of this wire manually.
FFT spectrum (Vrms) returns the averaged FFT spectrum in Vrms scaling, starting at frequency f0
with frequency interval df.

f0 returns the start frequency of the spectrum, expressed in Hz.
df returns the frequency interval between data points in the
spectrum, expressed in Hz.
spectrum returns the averaged FFT spectrum.
spectral info out returns properties of the computed spectrum such as spectrum type, spectrum scale
(linear or dB), the window type used by the VI to compute the spectrum, window size, and FFT size.
Connect this parameter to subsequent VIs that contain the spectral info input parameter. Do not modify
the values.

NI 5660 RF Vector Signal Analyzer
Hardware Reference
This section includes information useful to the advanced user of the NI 5660
hardware, including module front panels, signal paths, block diagrams, and
calibration information.
NI 5660 Overview
Theory of Operation
Hardware Front Panels
Signal Paths
NI 5600 RF Downconverter Module Block Diagram
NI 5620 IF Digitizer Module Block Diagram
Calibration
Note Refer to the NI 5660 RF Vector Signal Analyzer Specifications document included in the RF Signal
Analyzer kit for complete hardware specifications.

NI 5660 Overview
The NI 5660 is a modular RF vector signal analyzer consisting of two PXI
hardware modules:
NI 5620 — 14 bit, 64 megasample-per-second (MS/s) IF digitizer module
NI 5600 — wideband RF downconverter module with input frequencies
between 9 kHz and 2.7 GHz.
The hardware modules interconnect using the included SMA-SMA coaxial
cables as shown below.
Note There is no physical device labeled the "NI PXI-5660." The NI 5660 RF Vector Signal Analyzer is
the instrument comprised of the two hardware modules (NI 5600 and NI 5620) and the software included
in the kit.

Interconnected NI 5660 Front Panels
The NI 5660 has the following characteristics and features:
9 kHz to 2.7 GHz frequency range
20 MHz real-time bandwidth
10 MHz oven-controlled crystal oscillator (OCXO) timebase
±20 ppb frequency stability
±50 ppb frequency accuracy
>80 dB spurious-free dynamic range
+30 dBm full signal input range
Up to 64 MS of onboard waveform memory

Software for performing frequency-domain and IQ measurements
Four slots wide PXI/3U Compact PCI form factor
The NI 5660 follows industry-standard Plug and Play specifications for the PXI
bus and seamlessly integrates with compliant systems.

NI 5660 Theory of Operation
The NI 5600 downconverter module (block diagram) performs two primary
functions: frequency shifting, or downconversion, and input signal conditioning.
Frequency shifting is performed using a tunable oscillator in the superheterodyne
signal chain.
Input signal conditioning is accomplished using three stages of mixer conversion
and two sets of gain attenuators whose levels are programmable. The first set of
attenuators can be set to minimize distortion and other spurious signals when
input levels are high and to minimize noise when input levels are low. Attenuator
levels are set using the ni5660 Configure for Spectrum VI and the ni5660
Configure for IQ VI.
The second set of attenuators is in the second intermediate frequency (IF) path
before the third mixer and ensures an appropriate output signal level even if the
first mixer is intentionally driven into compression. These attenuators are also
set when performing linearity measurements. For more information on proper
attenuation levels, refer to Guidelines for Making Accurate Measurements.

Hardware Front Panel Connectors and Indicators
These sections describe the connectors and LED indicators on the front panels of
the NI 5660 hardware modules. All inputs and outputs are AC-coupled.

Click a Module Front Panel for Description

NI 5600 Front Panel
This sections describe the connectors and LED indicators on the hardware front
panel of the NI 5600 RF downconverter module. All inputs and outputs are ACcoupled.
Connector

Use

FREQ REF IN Routes an external frequency reference signal to which the NI 5600 can lock. This signal can be
propagated to the PXI backplane when the NI 5600 is installed in PXI Slot 2.
10 MHz OUT Connect the lower 10 MHz OUT connector to the REF CLK IN connector on the NI 5620 module
10 MHz OUT front panel. Both connectors output replications of the downconverter 10 MHz frequency
reference signal, useful for driving other devices. Each replication is 180 degrees out-of-phase
with the other. The signal output at these connectors is always on and cannot be disabled.
PXI 10 MHz
I/O

Bidirectional connection to the PXI 10 MHz backplane clock.
This connector can be used to drive the PXI 10 MHz backplane clock only when the NI 5600
downconverter module is installed in PXI Slot 2. To drive the PXI backplane with the NI 5600
onboard frequency reference, connect the PXI 10 MHz I/O connector to the 10 MHz OUT
connector on the NI 5600 RF downconverter module front panel as shown in Interconnected
NI 5600 Front Panels. Refer to the ni5660 Configure Reference Clock VI for more information.
This connector can be used to export the PXI 10 MHz backplane clock when the NI 5600
downconverter is installed in any PXI slot.

OUTPUT

Connect to the INPUT connector on the NI 5620 digitizer module front panel.
Outputs the frequency-translated IF signal for digitization.

INPUT

Connect to the analog RF input signal to be measured by the RF Vector Signal Analyzer.

The following table provides LED and indications information for the NI 5600
RF upconverter module front panel LEDs:
LED

Indications

POWER Indicates the basic hardware power status of the NI 5600 downconverter module. This LED functions
identically to the ACCESS LED on the digitizer module front panel.
OFFThe module is not yet functional, or has detected a problem with a PXI power rail.
GREENThe module is functional and receiving power.
STATUS Indicates the status of the NI 5600 downconverter module PLLs.
OFFThe module is in an uninitialized state, or the module PLLs are attempting to lock.
GREENThe module is in a ready state; applicable PLLs are locked.
Note Refer to the NI 5660 RF Vector Signal Analyzer Specifications document included in the NI 5660
RF Signal Analyzer kit for more information on NI 5600 connectors.

NI 5620 Front Panel
This section describes the connectors on the hardware front panel of the NI 5620
IF digitizer module. All inputs and outputs are AC-coupled.
Connector
INPUT

Use
Inputs a frequency-translated IF waveform from the NI 5600 downconverter for digitization and
measurement.
Connect to the OUTPUT connector on the NI 5600 downconverter module front panel.

REF CLK Inputs the NI 5600 internal reference clock signal.
IN
Connect to the lower 10 MHz OUT connector on the NI 5600 downconverter module front panel.
PFI 1

Inputs a digital trigger from an external source. Refer to the NI-SCOPE Help, located at
Start»Programs»National Instruments»NI-SCOPE»Documentation, for more information about
triggering.
Note Refer to the NI 5620 Digitizer Specifications, available at Start»Programs»National
Instruments»NI-SCOPE, for more information on NI 5620 connectors.

NI 5660 Signal Paths
A signal takes the following path through the RF Signal Analyzer to the PXI
controller:
1. A signal enters the RF Signal Analyzer through the INPUT front panel
connector of the NI 5600 RF downconverter module.
2. The NI 5600 RF downconverter module zooms in on a 20 MHz block of
spectrum and frequency-translates it to center around 15 MHz. The
translated IF signal is sent to the NI 5600 downconverter module
OUTPUT connector.
3. The IF signal is passed from the NI 5600 RF downconverter module
front panel OUTPUT connector to the NI 5620 IF digitizer module front
panel INPUT connector.
4. The NI 5620 IF digitizer module filters and conditions the signal and
applies gain and dither.
5. The Analog-to-Digital Converter (ADC) converts the signal from analog
to digital.
6. The data is sent to onboard memory (the buffer).
7. The data is transferred to the host computer.

NI 5600 RF Downconverter Module Block Diagram
The NI 5600 RF downconverter module translates any 20 MHz-wide band of
incoming signal to center at 15 MHz. Thus the downconverter module converts
any block of spectrum, up to 20 MHz wide and centered anywhere between
9 kHz and 2.7 GHz, to an IF band between 5–25 MHz. The NI 5600 hardware
always downconverts a 20 MHz band. This IF band is then passed to the
NI 5620 digitizer module (block diagram), for further processing.

NI 5620 IF Digitizer Module Block Diagram
The NI 5620 is an IF high-speed digitizer module featuring a 14-bit analog-todigital converter (ADC) with deep onboard sample memory. Offering sample
rates of 1 kS to 64 MS/s and distortion-free performance, it has been designed to
complement the NI 5600 downconverter module (block diagram) in FFT
analysis applications.

Calibration
Every NI 5660 RF Vector Signal Analyzer is individually calibrated for accurate
frequency response at the factory and ships with a calibration certificate
verifying NIST-traceable accuracy levels.
During frequency-response calibration, the RF Signal Analyzer is used to
measure a NIST-certified high-precision signal. Any error in the returned data is
quantified as a set of calibration constants. These calibration constants are used
by the software to calculate and apply correction to your analysis based upon the
spectrum of interest. For more information on applying calibration correction,
refer to the example programs installed with the RF Signal Analyzer.
To preserve specified accuracy and NIST traceability, NI recommends returning
both modules of the RF Signal Analyzer to the factory for annual recalibration.
The RF downconverter module and the IF digitizer module are calibrated
independently of one another, not as a combined system. At this time,
recalibration of both modules can only be performed by NI. For more
information on calibration, contact NI or visit ni.com/calibration.

Important Information
Technical Support and Professional Services
Warranty
Copyright
Trademarks
Patents
Warning Regarding Use of NI Products

Technical Support and Professional Services
Visit the following sections of the National Instruments Web site at ni.com for
technical support and professional services:
Support—Online technical support resources at ni.com/support include
the following:
Self-Help Resources—For immediate answers and solutions, visit
the award-winning National Instruments Web site for software
drivers and updates, a searchable KnowledgeBase, product
manuals, step-by-step troubleshooting wizards, thousands of
example programs, tutorials, application notes, instrument drivers,
and so on.
Free Technical Support—All registered users receive free Basic
Service, which includes access to hundreds of Applications
Engineers worldwide in the NI Developer Exchange at
ni.com/exchange. National Instruments Applications Engineers
make sure every question receives an answer.
Training and Certification—Visit ni.com/training for self-paced
training, eLearning virtual classrooms, interactive CDs, and Certification
program information. You also can register for instructor-led, hands-on
courses at locations around the world.
System Integration—If you have time constraints, limited in-house
technical resources, or other project challenges, NI Alliance Program
members can help. To learn more, call your local NI office or visit
ni.com/alliance.
Declaration of Conformity (DoC)—A DoC is our claim of compliance
with the Council of the European Communities using the manufacturers
declaration of conformity. This system affords the user protection for
electronic compatibility (EMC) and product safety. You can obtain the
DoC for your product by visiting ni.com/hardref.nsf.
Calibration Certificate—If your product supports calibration, you can
obtain the calibration certificate for your product at ni.com/calibration.
If you searched ni.com and could not find the answers you need, contact your
local office or NI corporate headquarters. You also can visit the Worldwide
Offices section of ni.com/niglobal to access the branch office Web sites, which

provide up-to-date contact information, support phone numbers, email addresses,
and current events.

Warranty
The NI RF Signal Analyzer hardware is warranted against defects in materials
and workmanship for a period of one year from the date of shipment, as
evidenced by receipts or other documentation. National Instruments will, at its
option, repair or replace equipment that proves to be defective during the
warranty period. This warranty includes parts and labor.
The media on which you receive National Instruments software are warranted
not to fail to execute programming instructions, due to defects in materials and
workmanship, for a period of 90 days from date of shipment, as evidenced by
receipts or other documentation. National Instruments will, at its option, repair
or replace software media that do not execute programming instructions if
National Instruments receives notice of such defects during the warranty period.
National Instruments does not warrant that the operation of the software shall be
uninterrupted or error free.
A Return Material Authorization (RMA) number must be obtained from the
factory and clearly marked on the outside of the package before any equipment
will be accepted for warranty work. National Instruments will pay the shipping
costs of returning to the owner parts which are covered by warranty.
National Instruments believes that the information in this document is accurate.
The document has been carefully reviewed for technical accuracy. In the event
that technical or typographical errors exist, National Instruments reserves the
right to make changes to subsequent editions of this document without prior
notice to holders of this edition. The reader should consult National Instruments
if errors are suspected. In no event shall National Instruments be liable for any
damages arising out of or related to this document or the information contained
in it.
Except as specified herein, National Instruments makes no warranties,
express or implied, and specifically disclaims any warranty of
merchantability or fitness for a particular purpose. Customer's right to
recover damages caused by fault or negligence on the part of National
Instruments shall be limited to the amount theretofore paid by the
customer. National Instruments will not be liable for damages resulting
from loss of data, profits, use of products, or incidental or consequential
damages, even if advised of the possibility thereof. This limitation of the
liability of National Instruments will apply regardless of the form of action,

whether in contract or tort, including negligence. Any action against National
Instruments must be brought within one year after the cause of action accrues.
National Instruments shall not be liable for any delay in performance due to
causes beyond its reasonable control. The warranty provided herein does not
cover damages, defects, malfunctions, or service failures caused by owner's
failure to follow the National Instruments installation, operation, or maintenance
instructions; owner's modification of the product; owner's abuse, misuse, or
negligent acts; and power failure or surges, fire, flood, accident, actions of third
parties, or other events outside reasonable control.

Copyright
Under the copyright laws, this publication may not be reproduced or transmitted
in any form, electronic or mechanical, including photocopying, recording,
storing in an information retrieval system, or translating, in whole or in part,
without the prior written consent of National Instruments Corporation.

Trademarks
LabVIEW™, National Instruments™, NI™, ni.com™, and NI Developer
Zone™, are trademarks of National Instruments Corporation.
Other product and company names mentioned herein are trademarks or trade
names of their respective companies.

Patents
For patents covering National Instruments products, refer to the appropriate
location: Help»Patents in your software, the patents.txt file on your CD, or
ni.com/patents.

WARNING REGARDING USE OF NATIONAL
INSTRUMENTS PRODUCTS
(1) National Instruments products are not designed with components and
testing for a level of reliability suitable for use in or in connection with
surgical implants or as critical components in any life support systems
whose failure to perform can reasonably be expected to cause significant
injury to a human.
(2) In any application, including the above, reliability of operation of the
software products can be impaired by adverse factors, including but not
limited to fluctuations in electrical power supply, computer hardware
malfunctions, computer operating system software fitness, fitness of
compilers and development software used to develop an application,
installation errors, software and hardware compatibility problems,
malfunctions or failures of electronic monitoring or control devices,
transient failures of electronic systems (hardware and/or software),
unanticipated uses or misuses, or errors on the part of the user or
applications designer (adverse factors such as these are hereafter
collectively termed "system failures"). Any application where a system
failure would create a risk of harm to property or persons (including the
risk of bodily injury and death) should not be reliant solely upon one form
of electronic system due to the risk of system failure. To avoid damage,
injury, or death, the user or application designer must take reasonably
prudent steps to protect against system failures, including but not limited to
back-up or shut down mechanisms. Because each end-user system is
customized and differs from National Instruments' testing platforms and
because a user or application designer may use National Instruments
products in combination with other products in a manner not evaluated or
contemplated by National Instruments, the user or application designer is
ultimately responsible for verifying and validating the suitability of National
Instruments products whenever National Instruments products are
incorporated in a system or application, including, without limitation, the
appropriate design, process and safety level of such system or application.

Related Documentation
These documents may contain information that you might find helpful as you
use the NI-RFSA VIs and the RF Signal Analyzer. Refer to this document for
basic information on setup, configuration, and operation of the RF Signal
Analyzer hardware and software.
NI 5660 RF Vector Signal Analyzer Getting Started Guide, printed and
included in your NI 5660 RF Signal Analyzer kit. This document is also
available in PDF format at Start»Programs»National Instruments»NIRFSA»Documentation.
NI 5660 RF Vector Signal Analyzer Specifications, printed and included
in your NI 5660 RF Signal Analyzer kit. This document is also available
in PDF format online by searching www.ni.com/manuals.
NI 5620 IF Digitizer Module Specifications, printed and included in your
NI 5660 RF Signal Analyzer kit. This document is also available in PDF
format at Start»Programs»National Instruments»NI-SCOPE.
For the latest NI-RFSA development information, visit the NI Developer
Zone at ni.com/instruments. Search for the latest NI-RFSA examples at
ni.com/examples. These links require an internet connection.
Spectral Measurements Toolkit Help, accessible at
Start»Programs»National Instruments»Spectral
Measurements»Documentation. Refer to this file for information about
measurements and examples available for the RF Signal Analyzer.
Spectral Measurements Toolkit User Guide, accessible in PDF format at
Start»Programs»National Instruments»Spectral
Measurements»Documentation.
Modulation Toolkit Help, accessible from Start»Programs»National
Instruments»Modulation»LabVIEW Support. The Modulation Toolkit
integrates with SMT and NI-RFSA for modulation/demodulation
measurements and analysis.
NI High-Speed Digitizers Help, available at Start»Programs»National
Instruments»NI-SCOPE»Documentation. Refer to this file for
information on implementing trigging for the RF Signal Analyzer.
NI-TUNER Help, available at Start»Programs»National
Instruments»NI-TUNER»Documentation. Refer to this file for

information on low-level control and examples for the RF Signal
Analyzer.
Visit ni.com/manuals for the most current revisions of documentation and for
newly released documentation.

ni5660 VI Programming Flow
To programmatically configure the RF Vector Signal Analyzer hardware for data
acquisition in LabVIEW, use the ni5660 VIs. These VIs control both the NI 5600
RF downconverter module and the NI 5620 IF digitizer module as a single
instrument for frequency-domain and IQ data acquisitions. The ni5660 VIs are
located on the LabVIEW function palette at Instrument I/O»Instrument
Drivers»ni5660.
Two programming flows are used with the ni5660 VIs: a frequency-domain
acquisition programming flow, and an IQ acquisition programming flow. Every
application built using the ni5660 VIs must call the ni5660 Initialize and ni5660
Close VIs.
Note When programming the RF Vector Signal Analyzer, specify the NI 5620 IF digitizer module with
the DAQ Resource Name using the following syntax: DAQ::DeviceNumber. Specify the NI 5600 RF
downconverter module using the MAX device number without modifiers. Device numbers are obtained
from Measurement & Automation Explorer (MAX).

Frequency-Domain Measurements Programming Flow
Use the programming flow shown in below to acquire data and perform
frequency-domain measurements using the ni5660 VIs:

IQ Acquisition Programming Flow
Use the programming flows shown below to acquire IQ data in finite or
continuous modes, respectively:
Finite IQ Acquisition

Continuous IQ Acquisition
Note NI provides add-on software toolkits, such as the Spectral Measurements Toolkit (included) and
the Modulation Toolkit, to extend the measurement and analysis capability of the RF Signal Analyzer.
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